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Čo by ste mali vedieť

	Acrobat DC: Prejdite na Tools > Combine Files > Pridať súbory > Combine.
	Ukážka Apple: Otvorte súbor PDF a vyberte Zobraziť miniatúry. Vyberte umiestnenie vloženia. Vyberte Upraviť > Vložiť > Stránka zo súboru.
	PDF Merge: Prejdite na webovú stránku PDF Merge, vyberte Vyberte súbor, vyberte PDF a zvoľte Open. Opakujte pre druhý súbor PDF. Vyberte Zlúčiť.


Tento článok vysvetľuje, ako skombinovať súbory PDF do jedného dokumentu pomocou aplikácie Acrobat DC, Mac Preview a webovej stránky PDF Merge. Poskytujú sa ďalšie informácie o kombinovaní súborov PDF na mobilných zariadeniach a používaní funkcie Kombinovať PDF a Zlúčiť PDF.



Ako zlúčiť súbory PDF s aplikáciou Adobe Acrobat DC

Adobe Acrobat Reader je zadarmo. Acrobat Reader môžete použiť na zobrazenie a tlač súborov PDF, ako aj na pridávanie anotácií. Ak chcete s týmito súbormi ďalej manipulovať alebo skombinovať viacero súborov PDF do jedného, nainštalujte si Acrobat DC.

Ak chcete zlúčiť súbory PDF s aplikáciou Adobe Acrobat DC, postupujte podľa týchto krokov:

	
Otvorte Acrobat DC a vyberte Tools > Combine Files.




Image


	
Vyberte Pridať súbory a pridajte toľko súborov, koľko chcete. Vyberte Pridať otvorené súbory, ak chcete zahrnúť dokumenty, ktoré si práve prezeráte.




Image


	Upravte poradie vrátane poradia jednotlivých stránok presunutím každej stránky na požadované miesto.
	
Vyberte Combine na dokončenie procesu.




Image




Acrobat DC je k dispozícii za mesačný alebo ročný poplatok za predplatné, ktorý sa líši v závislosti od verzie aplikácie a dĺžky viazanosti. Ak potrebujete krátkodobú potrebu, spoločnosť Adobe ponúka 7-dňovú bezplatnú skúšobnú verziu, ktorá neobsahuje obmedzenia z hľadiska funkčnosti.



Ako skombinovať súbory PDF s Apple Preview

V počítači Mac použite vstavanú aplikáciu Preview na kombinovanie súborov PDF, čím sa eliminuje potreba (a náklady, keďže Preview je v systéme macOS zadarmo) pre softvér tretích strán alebo online službu.

	Otvorte jeden zo súborov PDF, ktoré chcete skombinovať, v aplikácii Preview.
	
Prejdite do ponuky Zobraziť a vyberte Miniatúry, ak nie je vybratá, čím aktivujete náhľad miniatúr.

Ak chcete prepnúť zobrazenie miniatúr, stlačte Option+ Command+ 2 na klávesnici.




Image


	
Ak má otvorený súbor PDF viac ako jednu stranu, vyberte v ľavom paneli miniatúru, kam chcete vložiť ďalší súbor PDF.

Vložené stránky PDF sa zobrazia za vybratou stranou.




Image


	
Vybrať Upraviť > Vložiť > Stránka zo súboru.




Image


	V okne Finder nájdite druhý súbor PDF, ktorý chcete importovať do aktuálneho, a potom vyberte Otvoriť.
	Zopakujte kroky 4 a 5 pre každý ďalší súbor PDF, ktorý chcete importovať.
	Potiahnutím miniatúr zmeňte poradie strán.
	Keď ste spokojní s kombinovaným PDF, vyberte File > Uložiť.




Ako skombinovať súbory PDF so zlúčením PDF

Služby spájania súborov PDF ponúkajú viaceré webové stránky. Mnohé sú riadené reklamami a sú bezplatné. Jedným z nich je PDF Merge, ktorý umožňuje nahrať viacero súborov pomocou webového prehliadača. Pre nahrávané súbory je limit 10 MB.

PDF Merge ponúka aj cenovo dostupnú aplikáciu na stiahnutie, ktorá spája súbory PDF offline. K dispozícii je iba verzia pre Windows.

	Prejdite na webovú stránku PDF Merge.
	
Vybrať Vybrať súbor.




Image


	Vyberte prvý súbor PDF, ktorý chcete zlúčiť, a potom vyberte Otvoriť.
	
Znova vyberte Vyberte súbor pre ostatné súbory, ktoré chcete skombinovať. Ak sa vám minú sloty, vyberte More Files.




Image


	
Vyberte Zlúčiť na spojenie vybratých súborov.

Súbory sa skombinujú v poradí, v akom vyberiete a nahráte jednotlivé súbory.




Image


	Stiahnite si konečný kombinovaný súbor PDF do svojho počítača.




Ako kombinovať súbory PDF s kombináciou PDF

Combine PDF je webový nástroj, ktorý spája viacero dokumentov PDF do jedného súboru PDF. Zlúčte zadarmo až 20 súborov vrátane obrázkov do jedného súboru PDF. Skombinujte nároky PDF a odstráňte všetky súbory z ich serverov do jednej hodiny od nahrania.

	
Prejdite na kartu Kombinovať PDF, ak nie je vybratá.




Image


	
Presuňte súbory PDF na webovú stránku Zlúčenie PDF. Alebo nahrajte súbory tradičným spôsobom výberom Nahrať súbory.




Image


	Upravte poradie nahraných súborov pretiahnutím súborov vo fronte.
	
Vybrať Kombinovať.




Image


	Zlúčený súbor PDF, combinepdf.pdf, sa stiahne do vášho počítača.




Ako skombinovať súbory PDF z cloudu so zlúčením PDF

Merge PDF, súčasť stránky Smallpdf.com, je bezplatné riešenie založené na prehliadači, ktoré zahŕňa súbory z vášho lokálneho zariadenia, Dropboxu a Disku Google. Predtým, ako skombinujete súbory do jedného súboru PDF, použite Zlúčiť PDF na presunutie súborov, aby ste zmenili poradie alebo vymazali strany podľa potreby.

Všetky nahrávania a sťahovania sa považujú za bezpečné a súbory sa zo serverov Smallpdf do hodiny natrvalo odstránia. Stránka ponúka aj ďalšie služby súvisiace s PDF, vrátane nástrojov na prezeranie a úpravu a možnosť konvertovať formáty súborov.

	
Vyberte buď Z Disku Google alebo Z Dropbox a otvorte prihlasovacie okno.




Image


	Zadajte svoje prihlasovacie údaje do cloudovej služby, aby ste videli svoje cloudové súbory.
	Vyberte súbory, ktoré chcete nahrať, a potom vyberte Vyberte.




Ako kombinovať súbory PDF na mobilných zariadeniach

Existujú aplikácie pre Android a iOS, ktoré kombinujú súbory PDF v smartfóne alebo tablete. Mnohé mobilné aplikácie, ktoré sľubujú túto funkciu, buď neprinášajú očakávané výsledky, alebo sú zle vyvinuté, čo má za následok časté zlyhania a iné nespoľahlivé správanie. Tieto možnosti sú najspoľahlivejšie:

	PDF Utils: Táto často aktualizovaná aplikácia kombinuje veľké množstvo súborov PDF zo zariadenia so systémom Android a má ďalšie užitočné funkcie. Základná funkcia je k dispozícii bez poplatku, zatiaľ čo nákupy v aplikácii môžete využívať bez reklám.
	PDF Utility: Napriek niektorým obmedzeniam v bezplatnej verzii tejto aplikácie pre Android, vrátane maximálnej veľkosti súboru 2,5 MB, PDF Utility rýchlo zlúči dva alebo viac PDF dokumentov. Verzia Pro ruší toto obmedzenie a odstraňuje všetky reklamy.
	PDF Converter: Táto aplikácia pre iOS pomerne jednoducho kombinuje súbory PDF na zariadeniach Apple iPhone alebo iPad. Nákupy v aplikácii odstraňujú niektoré obmedzenia veľkosti a počtu súborov.
	PDF Expert: Jedna z najznámejších a stabilnejších aplikácií pre iOS v tomto zozname. Cenovka programu PDF Expert stojí za to, ak pravidelne kombinujete súbory PDF z knižnice iCloud.












Odporúča:


Ako skombinovať funkcie ROUND a SUM v Exceli




Naučte sa kombinovať funkcie ROUND a SUM v Exceli. A naučte sa vkladať funkcie tak, aby sa správali podľa želania. Aktualizované tak, aby zahŕňalo Excel 2019

Odstrániť dočasné internetové súbory a súbory cookie



Vyrovnávacie pamäte prehliadača Internet Explorer sú webové stránky, ktoré navštívite, a súbory cookie pochádzajúce z týchto stránok. Udržujte vyrovnávaciu pamäť malú a často ju vymazávajte

Ako skombinovať dva stĺpce v Exceli



Ak chcete skombinovať dva stĺpce v programe Microsoft Excel bez straty údajov, budete musieť použiť vzorec CONCATENATE a potom skopírovať a prilepiť výsledky ako hodnotu. Tu je návod

Ako skombinovať viacero súborov JPEG do jedného PDF



V systéme Windows alebo Mac môžete vytvoriť viacero súborov JPEG do jedného PDF pomocou vstavaných nástrojov alebo online programu, ako je konvertor JPG na PDF

Ako skombinovať dva alebo viac účtov Gmail



Máte dva alebo viac účtov Gmail, ktoré chcete zlúčiť do jedného? Tu je postup, ako skombinovať účty Gmail






















Populárne príspevky


	









Ako rýchlo zrušiť predplatné HBO Max

2024







	









Ako to opraviť, keď sa Chromebook nepripojí k sieti Wi-Fi

2024







	









Ako urobiť ohňostroj v Minecrafte

2024





















Najlepšie názory na mesiac


	



Čiernobiela fotografia: Vytvorte skvelé obrázky B&W







	



Prečo môžu byť bezkontaktné platby novým normálom







	



Ako odstrániť stiahnuté súbory na akejkoľvek platforme







	



2 najlepšie PC Sticks roku 2022







	



Ako by AI mohla sledovať a využívať vaše emócie







	



Môžete zrušiť odoslanie snímky? Nie, ale môžete to odstrániť







	



Ako hrať Animal Crossing: New Leaf pre Nintendo 3DS







	



7 najlepších podkrovných antén roku 2022







	



Prečo by ste v skutočnosti mohli potrebovať 1 TB iPhone







	



Ako používať videokameru – základné tipy pre videokameru







	



Ako môže inovovaný iPad spôsobiť, že niektoré MacBooky budú zastarané







	



Ako prepojiť telefón s Androidom s jednotkou Flash







	



Ako vykonať čistú inštaláciu OS X Mountain Lion na spúšťacom disku







	



Koľko iPadov sa predalo?







	



Pridajte e-mailovú adresu na obnovenie účtu do svojho účtu Microsoft
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IPad vs. iPhone vs. iPod touch

2024







	









Zoraďte si doručenú poštu Outlooku podľa e-mailového účtu

2024







	









Recenzia Nixplay Seed Ultra: Rám s vysokým rozlíšením a výhodami Wi-Fi

2024






























Poradenstvo


	



Čo je mini LED?

Mini LED patria medzi štandardné a Micro LED. Zistite, ako Mini LED zlepšujú výkon TV a PC monitora v porovnaní s tradičnými LED a ako sú v porovnaní s Micro LED







	



Ako zmeniť Fitbit Charge 2 Bands

Vedeli ste, že náramok na väčšine fitness trackerov Fitbit môžete vymeniť za rôzne štýly? Tu je návod, ako zmeniť remienok Fitbit Charge 2 tak, aby odrážal váš osobný štýl







	



Ako používať ID volajúceho v iPhone, čakajúci hovor & Viac

V našom rýchlom a jednoduchom návode sa naučte, ako na svojom iPhone používať ID volajúceho, presmerovanie hovorov a čakajúci hovor







	



Ako pridať hudbu do Fitbit Versa

Ak nechcete nosiť telefón so sebou, ale chcete mať pri cvičení hudbu, môžete použiť hudobné funkcie Fitbit a pridať si do hodiniek hudbu, ktorú budete môcť počúvať na cestách. Tu je návod







	



Všetko, čo môžete robiť pomocou Force Touch na Apple Watch

Force Touch na Apple Watch vám ponúka viac možností, keď stlačíte ciferník hodiniek. Tu sú všetky veci, ktoré môžete robiť s touto takmer skrytou funkciou




















Odborný názor


	



Recenzia Samsung UN65NU8000FXZA: Priemerný inteligentný televízor za vysokú cenu

Testovali sme UN65NU8000FXZA a zistili sme, že aj keď ide o slušný displej, jeho zastaraná technológia nie je priaznivá v porovnaní s modernejšími televízormi







	



Ako otvoriť terminál na Macu

Zobrazuje sa vám aplikácia Terminál na Macu, ale neviete, ako ju používať? Tu je návod, ako otvoriť Terminál na Macu a použiť niekoľko jednoduchých príkazov, aby ste ho mohli začať používať







	



Recenzia Yamaha RX-V483: Dobrá hodnota, aj keď chýba podpora formátu

S HD a UltraHD diskami, ktoré ponúkajú ohromujúce rozlíšenie a úžasný zvuk, všetci chceme prijímač domáceho kina, ktorý sa vyrovná. Testovali sme Yamaha RX-V483, aby sme zistili, či dokáže držať krok so zvyškom vášho domáceho kina







	



Recenzia Onkyo TX-NR575: Skvelý zvuk so zlou implementáciou funkcií

Televízor s vysokým rozlíšením si zaslúži zvuk s vysokým rozlíšením, ale môžete ho získať za menej ako 400 USD? Testovali sme Onkyo TX-NR575, aby sme zistili, či dokáže poskytnúť zvukový zážitok hodný vášho nového televízora







	



Recenzia Onkyo TX-SR373: Fantastický, lacný a nenáročný prijímač domáceho kina

Keďže sa naše televízory zväčšujú a rozlíšenie rastie, chceme zvuk, ktorý tomu zodpovedá. Testovali sme Onkyo TX-SR373, aby sme zistili, či dokáže ponúknuť kvalitu zvuku, ktorú si váš 4K televízor zaslúži
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Ako uložiť viacero e-mailov do jedného súboru v Mac OS X Mail

Viac ako jeden e-mail, ale iba jeden súbor na vašom Macu. Tu je návod, ako uložiť viacero správ do jedného kombinovaného textového súboru v Mac OS X Mail







	



Prekonanie závislosti na Facebooku

Vyskúšajte tieto nápady, ktoré vám pomôžu prestať plytvať životom na najväčšej sociálnej sieti na svete







	



Ako uložiť e-mail ako súbor PDF

Chcete uložiť e-mail bez toho, aby ste ho vytlačili? Ukážeme vám, ako uložiť e-mail do súboru PDF z obľúbených poštových služieb vrátane Gmailu a Yahoo







	



Ako triediť správy v Yahoo Mail

Naučte sa, ako si usporiadať Yahoo Mail podľa svojich predstáv. Správy Yahoo Mail môžete triediť podľa dátumu, odosielateľa, predmetu alebo veľkosti správy







	



Ako vyrobiť lektvar Splash v Minecrafte

Na výrobu lektvaru v Minecrafte potrebujete elixír, stojan na varenie a pušný prach. Namiesto pitia môžete hodiť špliechací lektvar
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